
 Interactive Mathematics Ver. 3 
Page 1 

 
 

QUICK START GUIDE TO INTERACTIVE MATHEMATICS 

 
This document describes the technical set-up of Interactive Mathematics and how to 
preview the lessons. These activities can be performed prior to the Academic Systems 
faculty training session. 
 
CONTENTS 
 
• Section 1: Technical Environment 
• Section 2: Introduction and Overview 
• Section 3: Lesson Viewer 
• Section 4: Lesson Review 

Getting Started Lesson 
Sample reports 
Sample Wrap-around features 

 
• Section 5: Going Online 

Server access instruction 
Log-in instruction 
Reviewing lessons online 

 
• Section 6: Lesson Architecture, Tools, and Customization Options 

Summary of lesson structure and support links 
Faculty-created customization options 

 
• Section 7: Faculty Materials and Resources 
• Section 8: Student Materials and Resources 
• Section 9: Appendix A: Scope and Sequence  

 
SECTION 1: TECHNICAL ENVIRONMENT 
 
This section describes six basic aspects of the Interactive Mathematics technical 
environment. 
• Technical specifications: 

The following URL is the location for current technical specifications for 
student and faculty computer workstations: http://support.academic.com. 
Click FAQ and review system requirements under Getting Started. 
Provide this information to the Information Technologist at your campus. 
Administrative privileges may be required to install the software. 
Provide this information to students before they install the Interactive 
Mathematics Client Installer software on their home or work computers.  

 

http://support.academic.com/
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• Server and database: 
A server houses the Instructional Support System database that keeps track 
of student work.  
The server may be either campus-owned or hosted by Academic Systems. 
Instructors set up courses and enroll students in Interactive Mathematics 
through the Instructional Support System. Academic Systems consultants 
provide training. 

 
• Computer workstation (client): 

Interactive Mathematics lessons run on personal computers.  
An Interactive Mathematics Client CD is installed on the computer 
workstation to enable the Interactive Lessons to run. 
Headphones or computer speakers are required. 

 
• Internet connection: 

Students must be connected to the Internet while working on Interactive 
Mathematics lessons. This permits their work to be saved in the Instructional 
Support System.  
Internet service is provided through a campus network or by students’ home 
or work Internet Service Providers. 
Students are responsible for obtaining their own Internet Service Providers. 

 
• Installation software: 

Server software: Academic Systems sends the server software to the campus 
Information Technologist if a campus houses the Interactive Mathematics 
server. No server software is shipped if the campus database is on an 
Academic Systems server (“hosted”). 
Interactive Mathematics Lesson Viewer. Only faculty members receive this CD 
that enables them to preview lessons when not connected to the server. 
Lesson Viewer use is described in Section 3. 
Interactive Mathematics Client installer. Each user receives this CD that 
enables them to use Interactive Mathematics lessons. Client Installer use is 
described in Section 5. 

 
• Lesson software: 

Lessons for each Interactive Mathematics course are contained on two CDs.  
The appropriate lesson CD must be in the CD drive whenever a student 
works on a lesson or an instructor previews a lesson.  
When a student works on an Interactive Mathematics lesson, his/her progress 
is saved on the server and a record of student work appears in the 
Instructional Support System. 



 Interactive Mathematics Ver. 3 
Page 3 

 

SECTION 2: INTRODUCTION AND OVERVIEW 

 
• Interactive Mathematics (IM) uses a computer-based, multimedia approach to teaching 

mathematics. Online lessons provide 
Basic instruction in key mathematical concepts 
Frequent feed-back and recommendations based on student performance 
Links to homework assignments in the PAN (Personal Academic Notebook) 
Options for faculty customization 

 
• A more detailed explanation of the Interactive Mathematics philosophy, design, 

features, and teaching approach is in the Interactive Mathematics Instructor’s Guide. 
 

SECTION 3: LESSON VIEWER 

 
• The Interactive Mathematics Lesson Viewer enables you to preview Interactive 

Mathematics lessons without connection to a server. No progress report is 
generated. The viewer is useful for: 

Preparing lessons 
Showing lessons or sample student reports to faculty members 
Training faculty members to teach with Interactive Mathematics 

 
INSTALL THE INTERACTIVE MATHEMATICS LESSON VIEWER 
 
• Close all Windows applications before you begin Viewer installation. 
• Refer to instructions on the insert, which is included with the IM Lesson Viewer.  
• Please consult your campus Information Technology staff before installing the 

Interactive Mathematics Lesson Viewer on your machine. Administrative login 
privileges may be required to install programs. 

• Insert the IM Lesson Viewer CD into your CD-ROM drive. The installation program 
should start automatically. If Auto play is not enabled on your computer, select Run 
from the Start Menu and type d:\setup.exe, where d represents your CD drive. 
See Figure 3-1. 

 
Figure 3-1 

 
• Complete the installation of the IM Lesson Viewer. This will take 5 to 15 minutes 

depending on the speed of your computer. An icon will be placed on your desktop 
called Math Viewer. See Figure 3-2. 

 
Figure 3-2 

 



 Interactive Mathematics Ver. 3 
Page 4 

ON-GOING USE 
  
• Leave the Interactive Mathematics Viewer installed on your computer; the icon 

will remain visible on the desktop. 
• Use the Viewer whenever you would like to review lessons and you are not 

connected to the Internet.  
• The Viewer is a stand-alone application (not networked via the Internet to the 

database) so your progress is not saved on a server. 
 

SECTION 4: LESSON REVIEW 

 
For this section, you will need the following materials. (A complete listing of all 
Interactive Mathematics materials and resources is included in Sections 7 and 8.)  
• IM PAN(s) 
• IM lesson CDs 
 
COMPLETE THE GETTING STARTED LESSON 
 
The GETTING STARTED lesson will acquaint you with the basic navigation and features of an 
IM lesson. This lesson is included on each Part I lesson CD. GETTING STARTED is an 
excellent tool for student orientation at the start of an IM course. 
• Run the Math Viewer program by clicking on the Viewer icon on your desktop. 
• Click OK on the log-on screen (no password required). See Figure 4-1. 
 

 
Figure 4-1 
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• Select your course on the following screen. Double click the title, or click the title 

once to highlight and click the page-turning arrow in the lower right of the screen. 
See Figure 4-2. 

 

 
Figure 4-2 

 
• Place the PART 1 lesson CD into your CD-ROM drive. 
• Put on your headphones or turn on your speakers. 
• Select the GETTING STARTED lesson. Double click on the title or click the lesson title 

once to highlight and click the page-turning arrow in the lower right of the screen. 
See Figure 4-3. 

 

 
Figure 4-3 

 
• Follow the audio instructions and complete the GETTING STARTED lesson. This lesson 

will orient you to the navigation and support features of the Interactive Mathematics 
lessons. 

• Exit the lesson by choosing Quit from the File menu. Be sure to leave the CD in the 
drive until you have completely exited the lesson. 

• Review of lesson architecture, tools, and customization options is included in 
Section 6 of this guide. 

 
COMPLETE OTHER LESSONS 
 
• Follow the procedure above to complete other lessons. The Interactive Mathematics 

Scope and Sequence document summarizes the lesson objectives. This document is 
included in Appendix A of this guide. 
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• Review additional lesson materials in the Personal Academic Notebook (PAN) of the 
associated course. 

• Review architecture, features, and tools in Section 6 of this guide. 
• Exit a lesson by choosing Quit from the File menu. Be sure to leave the CD in the 

drive until you have completely exited a lesson. Note: In an active student session, 
the exiting point from a lesson is book-marked. Students can easily return to the 
most recent point of work upon the subsequent login. 

 
EXAMINE SAMPLE REPORTS 
 
The following documentation will walk you through a mock-up of the Web Reports 
interface. (Details on this feature can be found in the Web Reports section of the 
Quick-Start Guide to the Instructional Support System.) 
• Click Web Reports on the left side of the screen. See Figure 4-4. 
 

 
Figure 4-4 

 
• Click Go On at the Instructional Support System-Reports screen. (Remember this 

is a mock-up - campus name, login, and password are not required.) See Figure 4-5. 
 

 
Figure 4-5 
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• Choose Print/View Section Report on the Select a Report screen. See Figure 4-6 

below. This report will display a sample roster of a section with Evaluate scores for 
assigned lessons. 

 

 
Figure 4-6 

 
• Click Tina Gomez from the section report roster to view a sample student report 

of detailed lesson activity.  
• Details on report interpretation and suggestions for monitoring student progress 

can be reviewed in the Instructor’s Guide. 
 
VIEW LESSON WRAP-AROUND FEATURES 
 
A sample of the lesson wrap-around features can be viewed via the IM Lesson Viewer 
program. This sample is based on the Prealgebra lesson F3.1, Ratio and Proportion. To 
view this sample, the Part I Prealgebra CD is required. If you are not using this 
curriculum sequence, you may examine these features as you build your course within 
the Instructional Support System. Refer to Section 6 of this guide for an overview of 
these links. The Quick-Start Guide to the Instructional Support System provides 
guidance in creating these links.  
 
• Launch the Interactive Mathematics Viewer program from your desktop. 
• Click Do a Lesson on the left side of the screen. 
• Click Student Wraparound Demonstration on the menu. Click the page 

turning arrow in the lower right of this screen. 
• Place the Prealgebra Part I CD in your CD-ROM drive. 
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• Click F3.1 Ratio and Proportion on the following screen. Click the page turning 

arrow in the lower right. You will see the following introductory page to the lesson. 
See Figure 4-7. 

 

 
Figure 4-7 

 
• Click the Wrap-around links located on the right of the screen to view sample 

entries. There are five different links: Syllabus, Lesson Notes, Screen Notes, Home 
Page, and Links. (Note: The screen note icon does not appear until you are on a 
lesson content page.) 

• Click the page-turning arrow in the lower right. Navigate to screen 2 of 13 in the 
Ratio concept of the Explain module to view a sample Screen Note. 

• Click on the Wraparound links located on the right of the screen to view other 
sample entries. See Figure 4-8 below.  

 

 
Figure 4-8 

 
• Additional information on these features can be found in Section 6 of this guide and 

in the Quick-Start Guide to the Instructional Support System. 
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SECTION 5: GOING ONLINE 

 
You will need the following items to access IM from your host server. These items were 
included in your implementation materials. (A complete list of materials and resources is 
included in Sections 7 and 8.) 
• IM Client Installation CD 
• IM PAN(s) 
• IM lesson CDs 

 
INSTALL THE CLIENT 
  
• Install the Interactive Mathematics Client. Refer to instructions on the insert, which is 

included with the Client CD. 
• Consult your campus Information Technology staff before installing the Interactive 

Mathematics Client on your computer. Administrative login privileges maybe 
required to install programs. 

• The Interactive Mathematics icon will be placed on your desktop. See Figure 5-1a. (If 
you are working from a previously installed version, the desktop icon may be as in 
Figure 5-1b.) 

     
Figure 5-1a    Figure 5-1b 

 
ACCESS THE INTERACTIVE MATHEMATICS HOMEPAGE 
 
• Connect to the Internet. 
• Click the Interactive Mathematics icon. This will launch your browser and direct you 

to the Interactive Mathematics homepage. See Figure 5-2. 
 

 
Figure 5-2 
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PREVIEWING LESSONS IN THE INSTRUCTIONAL SUPPORT SYSTEM 
 
• Select your campus from the drop down list on the Interactive Mathematics 

homepage. 
• Click “Instructor.” 
• Click “Course” on the screen in Figure 5-3 below to access the login screen. 
 

. 
Figure 5-3 

 
• Login to your Interactive Mathematics account. Login and password information will 

be provided to you by the campus lead for this implementation. See Figure 5-4.  
 

 
Figure 5-4 

 
• You are logged on when the following Instructional Support System screen appears. 

See Figure 5-5. 
 

 
Figure 5-5 
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• Click Preview Lessons and select a curriculum path from the drop down menu. 
See Figure 5-6 

 

 
Figure 5-6 

 

• Insert an Interactive Mathematics CD in the CD drawer. 
• Select the lesson you plan to preview and click Preview Lesson on the right of 

the screen.  
• The lesson will launch. Review lesson architecture, tools, and customization 

features in Section 6 of this guide. 
• Other features of the Instructional Support System can be reviewed in the 

Quick-Start Guide to the Instructional Support System. 
 

SECTION 6: LESSON ARCHITECTURE, TOOLS, AND CUSTOMIZATION OPTIONS 
  
LESSON ARCHITECTURE 
 

• Each Interactive Mathematics lesson has identical architecture. Students quickly come 
up to speed with navigational strategies. Key architectural features are 

Lesson modules 
Support Features 
Audio Control 
Screen Information 

 
Lesson Modules 
Each IM lesson has six modules: Overview, Explain, Apply, Explore, Evaluate, and 
Homework. Figure 6-1 depicts a typical lesson screen; note the module buttons on the 
left. Table 1 provides a brief description of each module. 
 

 
Figure 6-1 
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Table 1 
 

SYMBOL NAME DESCRIPTION 

 
Overview 

Overview introduces the content of a lesson and provides 
students with an opportunity to take a pretest. A customized 
Learning Plan is generated based on the Pretest score. 

 

Explain 

Explain presents mathematical concepts and provides 
opportunities to check understanding as students learn. 
Each lesson introduction includes a video that connects the 
mathematical concepts in the lesson to real-world applications. 

 

Apply Apply provides an opportunity to practice concepts learned in 
Explain. 

 
Explore 

Explore encourages students to further investigate 
mathematical concepts and observe mathematical 
relationships. These investigations help students develop their 
understanding of underlying principles. Not all lessons have an 
Explore module. 

 

Evaluate 
Evaluate tests what students have learned in a lesson. Through 
the Instructional Support System, faculty can set the number of 
Evaluate attempts to 1, 2, or 3. 

 

Homework 

Homework refers students to their Personal Academic 
Notebook (PAN) for practice on the concepts covered in the 
lesson. 
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Support Features 
Interactive Mathematics lesson screens provide links for additional instructional support. 
Table 2 summarizes these support features. 
 

SYMBOL DESCRIPTION MODULE 

 

The Helpline offers the student hints and explanations of 
concepts in colloquial terms. 

Explain 
Explore 

 

 

Take a Closer Look provides the student with additional 
examples, alternative explanations, and other information 
to help students study a concept in greater detail. 

Explain 

 

 

Link to Explain takes students back to the section of 
Explain where the concepts were first introduced. After 
reviewing in Explain, students can return to Apply or 
Explore by clicking the Go Back icon in the lower right. 

Apply 
Explore 

slope Students can click underlined words or phrases to review 
its definition and view an example. 

Explain 
Explore 

 

Examples offer students additional examples and practice 
exercises. Explain 

 

The Journal allows students to take notes online. These 
notes can be saved, edited, and printed. The instructor 
does not have access to the student Journal 

Explain 
Explore 

Options menu 

 

Calculator Tips provide helpful tips on proper use of a 
calculator in problem solving. Explain 

 

The Expression Editor is an answer-processing tool 
which enables students to write complex mathematical 
expressions, equations, or inequalities. 

Explain 
Apply 

Explore 
Evaluate 

Table 2 
 
Audio Control 
• Interactive Mathematics lessons include audio. Students can adjust the audio by 

selecting Adjust Volume from the Options menu. See Figure 6-2. 
• Although the use of audio is highly recommended, students can choose to turn it off 

by selecting Turn Audio Off from the Options menu. See Figure 6-2. 
 

 
Figure 6-2 



 

 
• Students can also repeat or stop the audio on each screen by clicking the 

megaphone icon in the lower left of the screen. See Figure 6-3. 

Screen Information 
• Each Interactive Mathematics screen co

instructor with student lesson locatio

F

LESSON TOOLS 
 
Interactive Mathematics supports student w
tools:  

Calculator 
Journal 
Grapher 
Expression Editor 

 
Figure 6-3
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ntains information to assist the classroom 
n. See Figure 6-4 below. 

 
igure 6-4 

 

ork and problem solving with the following 
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These tools can be accessed via the Tools menu. See Figure 6-5. (The Expression Editor 
icon is displayed on the lesson screen when needed.)  
 

 
Figure 6-5 

 
Calculator 
• A scientific calculator is available to students at any time from the Tools menu. It 

opens in a separate window and can be repositioned on the screen for ease of use. 
• The Fundamentals lessons contain the Calculator Tips feature that models how to 

use a calculator for certain problems. 
• The calculator cannot be “turned off.” It is always accessible to students while in the 

IM lesson. 
 
Journal 
• The Journal tool allows students to take notes online. These notes can be saved and 

printed for future reference.  
• The program includes prompts to use the Journal on every lesson summary screen. 
• Students may open their Journals at any time from the Tools menu or clicking the 

Journal icon on a summary screen. See Figure 6-6. 
 

 
Figure 6-6 

 
Grapher 
• The Grapher enables students to plot points and graph linear equations, linear 

inequalities, quadratic functions, circles, and other relations. 
• User entered information is represented both algebraically and graphically.  
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• Students can access online help for using the Grapher from the Help menu. 
• The Grapher is integrated into relevant Explore modules and can is available for use at 

other times by selecting Grapher from the Tools menu. See Figure 6-7. 
 

 
Figure 6-7 

 
Expression Editor 
• This tool allows students to enter expressions, equations, or inequalities as answers 

to questions. 
• The Expression Editor uses answer-processing algorithms to support recognition of 

most alternate forms of correct answers. 
• An icon prompts the user when this tool is required for answer entry. Clicking on 

this icon opens the Expression Editor. See Figure 6-8. 
 

 
Figure 6-8 
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• Help using this tool can be found in the Help menu.  
• A tutorial on the Expression Editor can be accessed from the Interactive Mathematics 

homepage. Click Tips and Tutorials in the Resources menu. See Figure 6-9. 
 

 
Figure 6-9 

 
• Click “Expression Editor Tutorial” from the following menu. See Figure 6-10. 
 

 
Figure 6-10 

 
• To use the Expression Editor Tutorial, you will first need to download the tutorial 

files. This should take about six minutes using a 56 Kbps modem. Follow the 
directions on the Download Expression Editor Tutorial screen. See Figure 6-11. 

 

 
Figure 6-11 
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CUSTOMIZATION OPTIONS 
 

• Instructors can provide students course specific information within the Interactive 
Mathematics lessons. Five types of instructor-created information can be included on 
the lesson screen. Table 3 contains a list of the links and possible uses. 

  

SYMBOL NAME DESCRIPTION 

 
SYLLABUS 

A course syllabus, outline, or calendar can be attached. 
The link for this document will be on every screen of 
instruction for student reference. 

 

LESSON NOTE 

A note can be created and will be posted on every screen 
of instruction of the selected lesson. This is a global note 
and might be used as a reminder to students about due 
dates or a particular classroom procedure. 

 

SCREEN NOTE 

An individual note can be posted on each screen of 
instruction. These notes can be used to reinforce 
particular techniques that are presented or to caution 
students regarding pitfalls. 

 

HOME 
This link can be used to link students to an instructor’s or 
course website. 

 

LINKS 
This link allows instructors to create up to 5 links to 
websites that are useful to students as they work through 
IM lessons. 

Table 3 
 

• The wrap-around links are created within the Instructional Support System. Not all 
links have to be used. Any link that is not customized will not display an icon on the 
student lesson page. Figure 6-12 shows a lesson screen which has incorporated all of 
the wrap-around features. 

 

 
Figure 6-12 

 
• Instructions on building these links in your lessons can be reviewed in the Quick-Start 

Guide to the Instructional Support System. 
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SECTION 7: FACULTY MATERIALS AND RESOURCES 
 
Faculty materials exist in several formats and locations. A summary follows: 
Print Materials 
 
• Personal Academic Notebooks (PANs) – There are four PANs, one for each 

Interactive Mathematics course. These contain study notes, sample worked problems, 
homework and practice problems, and practice tests for every lesson. They are 
designed for students to use as a companion text to the online lessons. 

• Instructor’s Guide - A reference which provides the instructor with supporting 
information for IM implementations. The guide includes: an overview of Mediated 
Learning; a description of the course structure and content; sample syllabi; a scope 
and sequence of IM topics and lesson; descriptions of special features of the 
courseware; and suggestions for classroom management, student monitoring and 
evaluation. 

• Answer and Solution Guide – This book contains the answers and solutions to all 
homework and practice problems in the Personal Academic Notebook. 

 
CD-Based Materials 
• Mathematics Instructor’s CD 

Test Items and Answers – A resource that contains a variety of test items that 
you can use to create your own quizzes and/or exams. The Test Items and 
Answers book is a Microsoft Word document that is fully editable. 
Personal Academic Notebooks (PANs) 
2001 Update- This document outlines corrections that were made to each 
PAN in April 2001. 
Answers and Solutions Guide  
Instructional Support System User’s Guide – This book serves as a step-by-step 
reference guide to assist you in using the Instructional Support System. 
Instructor Guide  
Enrichment Activities – This book contains activities that examine lesson 
concepts in greater depth or apply concepts in new situations 
Collaborative Learning – This book contains activities for each topic with 
challenging questions for students to investigate in groups. 
Software Feedback Report 

 
• IM Lesson Viewer – The Viewer CD is an instructor resource that allows teachers 

to preview IM lessons. No connection to the IM server is required; no reports are 
generated.  

• Lesson CDs – The lesson CDs contain the IM content. Each course has two CDs: 
Part I and Part II. 

• Test Check – A program that allows faculty to create tests, quizzes, and other 
handouts. The items are algorithmically generated; faculty can customize and create 
individual questions. The created documents can be distributed in print form or via a 
LAN. 
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• Interactive Mathematics Client Installer – The program on this CD configures a 

computer to access the server running Interactive Mathematics. Along with your ISP, it 
is also the tool which supports access to the program and the management system 
off campus, provided that the server for Interactive Mathematics is internet accessible. 

 
Online Materials 
• Materials to assist with your knowledge of the Interactive Mathematics courseware 

and to assist in training other faculty can be found at http://training.academic.com. 
See Figure 7-1. 

 
Figure 7-1 

 
o Click LOGON. 
o Log in with the following information. See Figure 7-2. 

Username: math 
Password: math 

 
 

 
Figure 7-2 

 
o Click courses in which you are enrolled: ASC1000 - Interactive 

Mathematics (link on right of screen.) 

http://training.academic.com/


 Interactive Mathematics Ver. 3 
Page 21 

 
• Resources are available on the Interactive Mathematics homepage. Click links to 

“Getting Started” and “Tips and Tutorials” on the home page. See Figure 7-3. 
 

 
Figure 7-3 

 
o The Tips and Tutorials link under Resources provides access to the 

following: 
Interactive Mathematics Course Materials List 
Using the Interactive Mathematics Lesson 
Finding and Printing Interactive Mathematics Personal Academic 
Notebooks 
Getting Started Lesson 
Interactive Mathematics Study Tips 
How to Check Your Progress and Read and Send Comments to 
Your Instructor 
How to Use the Expression Editor 
Expression Editor Tutorial 
How to Use the Grapher 
Patch Manager 

 

SECTION 8: STUDENT MATERIALS AND RESOURCES 
 
Student materials are a combination of print, CD, and online support. A summary 
follows: 
 
Print Materials 
• Personal Academic Notebooks (PANs) – There are four PANs, one for each 

Interactive Mathematics course; students receive the PAN aligned for their course. 
These contain study notes, sample worked problems, homework and practice 
problems, and practice tests for every lesson. They are designed for students to use 
as a companion text to the online lessons.  
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CD-Based Materials 
• Lesson CDs – The lesson CDs contain the IM content. Each course has two CDs: 

Part I and Part II. 
• Interactive Mathematics Client Installer – The program on this CD configures a 

computer to access the server running Interactive Mathematics. Along with your ISP, it 
is also the tool which supports access to the program off campus, provided that the 
server for Interactive Mathematics is internet accessible. 

 
Online Materials 
• A variety of resources are available on the Interactive Mathematics homepage. Click 

links to “Getting Started” and “Tips and Tutorials” on the home page. See listing of 
resources from the IM homepage in the Faculty Online Materials in Section 7. 
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SECTION 9: APPENDIX 

 
A: Interactive Mathematics Scope and Sequence 

 
Lesson Concept Objectives Hours 

Topic F1: Whole Numbers 
F1.1 Whole Numbers I Adding and  a) Number line and ordering symbols  
  Subtracting b) Place value  
   c) Adding whole numbers  
   d) Subtracting whole numbers  
   e) Solving x ± a = b  
   f) Applications  
  Multiplying and a) Multiplying whole numbers 6-8 hours 
  Dividing b) Dividing whole numbers  
   c) Prime factorization  
   d) Solving ax = b  
   e) Applications  
  Rounding and  a) Rounding and estimating  
  Divisibility b) Divisibility  
   c) Applications  
F1.2 Whole Numbers II Exponential Notation a) Base  
   b) Exponent  
   c) Roots  
   d) Applications 4-6 hours 
  Order of Operations a) Grouping symbols  
   b) Order of operations  
   c) Distributive property and other properties of 

whole numbers 
 

   d) Combining similar terms  
   e) Applications  

 
Topic F2: Proportional Reasoning I 

F2.1 Fractions I Equivalent Fractions a) Fraction notation  
   b) Equivalent fractions (with larger or smaller 

denominators) 
 

   c) Simplify fractions (reducing to lowest terms)  
   d) Greatest common factor (GCF)  
   e) Applications  
  Multiplying and a) Mixed numerals and improper fractions 4-6 hours 
  Dividing b) Multiplying fractions  
   c) Finding reciprocals  
   d) Dividing fractions  
   e) Solving px = q  
   f) Applications  
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F2.2 Fractions II Common  a) Least common multiple (LCM)  
  Denominators b) Common denominators  
   c) Least common denominator (LCD)  
   d) Ordering fractions  
   e) Applications  
  Adding and  a) Fractions with the same denominators  
  Subtracting b) Fractions with different denominators 4-6 hours 
   c) Mixed numerals  
   d) Order of operations  
   e) Properties of rational numbers  
   f) Combining similar terms  
   g) Solving x ± p = q  
   h) Applications  
F2.3 Decimals I Notation a) Place value  
   b) Ordering decimals  
   c) Rounding and estimating  
   d) Applications 4-6 hours 
  Converting a) Converting decimals to fractions  
   b) Converting fractions to decimals  
   c) Irrational numbers  
   d) Applications  
F2.4 Decimals II Adding and a) Adding decimals  
  Subtracting b) Subtracting decimals  
   c) Combining similar terms  
   d) Solving x ± r = s  
   e) Applications  
  Multiplying and a) Multiplying decimals  
  Dividing b) Dividing decimals 4-6 hours 
   c) Multiplying and dividing by powers of 10  
   d) Converting fractions to decimals  
   e) Irrational numbers  
   f) Order of operations  
   g) Properties of real numbers  
   h) Solving rx = s  
   i) Applications  

 
Topic F3: Proportional Reasoning II 

F3.1 Ratio and Proportion Ratios a) Notation  
   b) Equivalent ratios  
   c) Rates  
   d) Applications 4-6 hours 
  Proportions a) Setting up a proportion  
   b) Solving a proportion  
   c) Similar triangles  
   d) Applications  
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F3.2 Percent Definition a) Percent as a fraction  
   b) Percent as a decimal  
   c) “Benchmark” percents  
   d) Applications  
  Converting a) Converting among fractions, decimals and 

percents 
6-8 hours 

   b) Percent increase and decrease   
   c) Applications  
  Solving Percent  a) Setting up and solving proportions  
  Problems b) Setting up and solving other equations  
   c) Applications  

 
Topic F4: Signed Numbers  

F4.1 Signed Numbers I Adding a) Signed numbers  
   b) Ordering signed numbers  
   c) Absolute value  
   d) Adding signed numbers  
   e) Applications 4-6 hours 
  Subtracting a) Subtracting signed numbers  
   b) Solving x ± a = b  
   c) Applications  
F4.2 Signed Numbers II Multiplying and  a) Multiplying signed numbers  
  Dividing b) Dividing signed numbers  
   c) Solving ax = b  
   d) Applications  
  Combining Operations a) Order of operations 4-6 hours 
   b) Distributive property and other properties of real 

numbers 
 

   c) Combining similar terms   
   d) Applications  

 
Topic F5: Geometry  

F5.1 Geometry I Geometric Figures a) Point, line, line segment, ray  
   b) Polygons  
   c) Measuring angles  
   d) Angles: acute, right, obtuse, straight 4 hours 
   e) Relationships between angles: complementary, 

supplementary, adjacent, vertical 
 

   f) Applications  
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F5.2 Geometry II Perimeter and Area a) Perimeter of a polygon  
   b) Area of a polygon  
   c) Area of a rectangle, square, parallelogram, 

triangle, trapezoid 
 

   d) Circumference of a circle  
   e) Area of a circle  
   f) Perimeter and area of composite figures  
   g) Applications  
  Surface Area and  a) Surface area of a solid 4-6 hours 
  Volume b) Volume of a solid  
   c) Surface area and volume of a rectangular prism  
   d) Surface area and volume of a cylinder  
   e) Volume of a cone  
   f) Volume of a sphere  
   g) Composite figures  
   h) Applications  
F5.3 Geometry III Triangles and  a) Angle sum of a triangle  
  Parallelograms b) Congruent triangles  
   c) Isosceles and equilateral triangles  
   d) Right triangles  
   e) The Pythagorean Theorem  
   f) Parallel lines and transversals  
   g) Properties of parallelograms 4-6 hours 
   h) Applications  
  Similar Polygons a) Similar polygons  
   b) Similar triangles  
   c) Applications  

 
Topic F6: Interpreting Data 

F6.1 Units of Measurement US/English Units a) Measures: length, weight, time, volume   
   b) Converting from one unit to another  
   c) Adding and subtracting measurements  
   d) Applications 4-6 hours 
  The Metric System a) The metric system: length, mass, volume  
   b) Fahrenheit and Celsius scales   
   c) Converting between US and metric units  
   d) Applications  
F6.2 Interpreting Graphs Data and Graphs  a) Reading data from graphs  
   b) Graphing data  
   c) Pictographs  
   d) Bar graphs 2-3 hours 
   e) Circle graphs  
   f) Line graphs  
   g) Applications  
F6.3 Introduction to  Statistical Measures a) Mean  
 Statistics  b) Median  
   c) Mode 2-3 hours 
   d) Box-and-whisker plots   
   e) Applications  
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Topic EI: Essentials — Preparing for Algebra 

EI.A Fractions Multiplying and a) Equivalent fractions  
 (reviews F2.1, F2.2) Dividing b) Prime factorization  
   c) Reducing to lowest terms  
   d) The greatest common factor (GCF)  
   e) Multiplying fractions  
   f) Finding reciprocals 4 hours 
   g) Dividing fractions  
  Adding and  a) Fractions with the same denominators  
  Subtracting b) The least common multiple (LCM)  
   c) The least common denominator (LCD)  
   d) Fractions with different denominators  
EI.B Signed Numbers Adding and  a) Adding signed numbers  
 (reviews F4.1, F4.2) Subtracting b) Subtracting signed numbers  
  Multiplying and a) Multiplying and dividing signed numbers  
  Dividing b) Exponential notation 4 hours 
   c) Distributive property and other properties of real 

numbers 
 

   d) Order of operations  
 

Topic 1: Real Numbers 
1.1 The Real Numbers Number Line and  a) Sets   
  Notation b) Subsets of real numbers: natural numbers, 

integers, rationals, irrationals 
 

   c) Graphing real numbers on a number line  
   d) Ordering symbols: =, <, >, ,  2 hours 
   e) The absolute value of a real number  
   f) Grouping symbols  
   g) Exponents  
1.2 Factoring and  The GCF and LCM a) Prime factors  
 Fractions  b) Greatest common factor  
   c) Least common multiple  
  Fractions a) Reducing to lowest terms 3 hours 
   b) Multiplication and division  
   c) Addition and subtraction  
1.3 Arithmetic of  Operations on  a) Addition  
 Numbers Numbers b) Subtraction  
   c) Multiplication  
   d) Division  
   e) Order of operations  
   f) Commutative law 2 hours 
   g) Associative law  
   h) Distributive law  
   i) Additive and multiplicative identities  
   j) Inverses  
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Topic 2: Solving Linear Equations and Inequalities 

2.1 Algebraic Expressions Simplifying  a) Constants and variables  
  Expressions b) Terms and coefficients  
   c) Combining like or similar terms  
   d) Parentheses 2 hours 
   e) Evaluating expressions  
   f) Formulas: Substitution  
2.2 Solving Linear  Solving Equations I a) Recognizing a linear equation  
 Equations  b) The addition and subtraction principles for solving 

a linear equation 
 

   c) The multiplication and division principles for 
solving a linear equation 

 

   d) Combining the principles 3 hours 
  Solving Equations II a) Equations with fractions as coefficients  
   b) Equations with no solutions or infinitely many 

solutions 
 

   c) Formulas: Solving for a particular unknown  
2.3 Problem Solving Number and Age a) Translating words into algebraic expressions  
   b) Number problems 4 hours 
   c) Age problems  
  Geometry a) Geometry problems  
2.4 Linear Inequalities Solving Inequalities a) Recognizing solutions of linear inequalities  
   b) Graphing solutions of inequalities in one variable  
   c) The addition and subtraction principles for solving 

a linear inequality  
2 hours 

   d) The multiplication and division principles for 
solving a linear inequality 

 

   e) Combining the addition, subtraction, 
multiplication, and division principles 

 

   f) Solving problems using inequalities  
 

Topic 3: Introduction to Graphing 
3.1 Introduction to Plotting Points a) The xy-plane   
  Graphing  b) The x-axis and y-axis  
   c) The origin  
   d) Ordered pairs  
   e) The x-coordinate (abscissa), the y-coordinate 

(ordinate)  
 

   f) Plotting ordered pairs of numbers  
   g) Labeling the four quadrants  
   h) Determining the quadrant in which a point lies 3 hours 
   i) The signs of the coordinates in each quadrant  
  Rise and Run a) Subscript notation  
   b) Geometric interpretation of rise and run  
   c) Algebraic definition of rise and run   
  The Distance Formula a) Pythagorean Theorem  
   b) The distance formula  
   c) The equation of a circle  
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Topic 4: Graphing Linear Equations and Inequalities 

4.1 Graphing Equations Graphing Lines I a) Definition of a linear equation in two variables  
   b) Recognizing linear equations in two variables  
   c) Solutions of linear equations   
   d) Graphing a linear equation by plotting ordered 

pairs 
 

  Graphing Lines II a) Equations and graphs of horizontal and vertical 
lines  

 

   b) The intercepts of a line 5 hours 
   c) Graphing a linear equation by finding the 

intercepts 
 

  Slope of a Line a) Definition of the slope of a line  
   b) Positive slope, negative slope, zero slope, 

undefined slope 
 

   c) Graphing a line given a point and the slope  
   d) Parallel and perpendicular lines  
4.2 The Equation of a Line Finding the Equation I a) Finding the equation of a line given a point on the 

line and the slope of the line 
 

   b) The point-slope form of the equation of a line  
   c) Finding the equation of a line given two points on 

the line 
 

  Finding the Equation II a) The slope-intercept form of the equation of a line 3 hours 
   b) Finding the equation of a horizontal line  
   c) Finding the equation of a vertical line  
   d) Finding the equation of a line parallel or 

perpendicular to a given line 
 

4.3 Graphing Inequalities Linear Inequalities a) Ordered pairs as solutions of linear inequalities 2 hours 
   b) Graphing inequalities   

 
Topic 5: Solving Linear Systems 

5.1 Solving Linear  Solution by Graphing a) The solution of a linear system  
 Systems  b) Graphing linear systems  
   c) Systems with a unique solution  
   d) Systems with no solutions  
   e) Systems with an infinite number of solutions 3 hours 
  Solution by Algebra a) Solving linear systems by the substitution method: 

one solution, no solution, and an infinite number of 
solutions 

 

   b) Solving linear systems by the elimination method: 
one solution, no solution, and an infinite number of 
solutions 

 

5.2 Problem Solving Using Linear Systems a) Number problems  
   b) Interest problems  
   c) Coin problems 2 hours 
   d) Mixture problems  
5.3 Systems of Inequalities Solving Linear Systems a) Solving systems of linear inequalities by graphing 2 hours 
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Topic 6: Exponents and Polynomials 

6.1 Exponents Properties of  a) Definition of exponent, power, and base   
  Exponents b) Multiplication property  
   c) Division property  
   d) Powers raised to powers 2 hours 
   e) Products raised to powers  
   f) Quotients raised to powers  
   g) The zero exponent  
6.2 Polynomial  Adding and  a) Definition of polynomial, term, and coefficient  
 Operations I Subtracting b) Evaluating a polynomial  
   c) The degree of a term and a polynomial  
   d) Writing the terms of a polynomial in descending 

order 
 

   e) Definition of a monomial, binomial, and trinomial  
   f) Recognizing like or similar terms 4 hours 
   g) Combining like or similar terms  
   h) Polynomial addition  
   i) Polynomial subtraction  
  Multiplying and  a) Multiplying a monomial by a monomial  
  Dividing b) Multiplying a polynomial by a monomial  
   c) Dividing a monomial by a monomial  
   d) Dividing a polynomial by a monomial  
6.3 Polynomial  Multiplying Binomials a) Multiplying binomials by the “FOIL” method  
 Operations II  b) Perfect squares, product of the sum and 

difference of two terms 
 

  Multiplying and  a) Multiplying a polynomial by a polynomial 4 hours 
  Dividing b) Dividing a polynomial by a polynomial  

 
Topic 7: Factoring 

7.1 Factoring  
Polynomials I 

Greatest Common 
Factor 

a) Finding the greatest common factor (GCF) of a 
set of monomials 

 

   b) Factoring a polynomial by finding the GCF when 
the GCF is a monomial 

 

  Grouping a) Factoring a polynomial by finding the GCF when 
the GCF is a binomial 

4 hours 

   b) Factoring a polynomial with four terms by 
grouping 

 

7.2 Factoring  
Polynomials II 

Trinomials I a) Factoring trinomials of the form  x2 + bx + c;   
x2 + bxy + cy2  

 

  Trinomials II a) Factoring trinomials of the form                            
ax2 + bx + c,  a ≠ 1, by trial-and-error 

4 hours 

   b) Factoring trinomials of the form                            
ax2 + bx + c, a ≠ 1, by grouping 

 

   c) Solving quadratic equations by factoring   
7.3 Factoring by Patterns Recognizing Patterns a) Factoring a perfect square trinomial  
   b) Factoring a difference of two squares  
   c) Factoring a sum and difference of two cubes 2 hours 
   d) Factoring using a combination of methods  
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Topic 8: Rational Expressions 

8.1 Rational Expressions I Multiplying and Dividing a) Determining when a rational expression is 
undefined 

 

   b) Writing a rational expression in lowest terms  
   c) Multiplying rational expressions  
   d) Dividing rational expressions  
   e) Simplifying a complex fraction 2 hours 
  Adding and Subtracting a) Adding rational expressions with the same 

denominator 
 

   b) Subtracting rational expressions with the same 
denominator 

 

8.2 Rational  Negative Exponents a) Notation  
 Expressions II  b) Scientific notation  
  Multiplying and Dividing a) Reducing a rational expression of the form 

(a -b)/(b-a) 
 

   b) Multiplying rational expressions  
   c) Dividing rational expressions  
   d) Simplifying a complex fraction  
  Adding and Subtracting a) Finding the least common denominator of two or 

more rational expressions 
3 hours 

   b) Adding rational expressions with different 
denominators 

 

   c) Subtracting rational expressions with different 
denominators 

 

   d) Simplifying a complex fraction  
8.3 Equations with  Solving Equations a) Solving equations with rational expressions  
 Fractions  b) Solving for an unknown in a formula involving a 

rational expression 
2 hours 

8.4 Problem Solving Rational Expressions a) Ratio and proportion  
   b) Distance problems 2 hours 
   c) Work problems  
   d) Variation  

 
Topic EII: Essentials of Algebra 

EII.A Real Numbers and 
Exponents  

Real Numbers and 
Notation 

a) Number line and notation: sets, ordering symbols, 
grouping symbols, exponents, and absolute value  

 

 (reviews 1.1, 1.3,  b) Operations on signed numbers 2 hours 
 6.1)  c) Properties of real numbers: commutative law, 

associative law, distributive law, additive and 
multiplicative identities, inverses  

 

  Integer Exponents a) Nonnegative integer exponents  
   b) Properties of exponents  
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EII.B Polynomials              

(reviews 2.1, 6.2, 7.1,  
Polynomial Operations a) Algebra building blocks: constants, 

variables, terms and coefficients  
 

 7.2)  b) Evaluating polynomials  
   c) Adding and subtracting polynomials  
   d) Multiplying and dividing polynomials  
  Factoring  a) Factoring out the greatest common factor  
  Polynomials b) Factoring by grouping 2 hours 
   c) Factoring trinomials  
   d) Factoring a difference of 2 squares  
   e) Factoring sums and differences of 2 cubes  
   f) Factoring using a combination of methods  
EII.C Equations and  Linear a) Solving linear equations 2 hours 
 Inequalities  b) Solving linear inequalities  
 (reviews 2.2, 2.4)    
EII.D Rational Expressions Rational Expressions a) Negative integer exponents  
 (reviews 8.1, 8.2)  b) Writing rational expressions in lowest terms  
   c) Multiplying and dividing rational expressions 2 hours 
   d) Adding and subtracting rational expressions  
  Rational Equations a) Solving equations that contain rational 

expressions 
 

EII.E Graphing Lines Graphing Lines a) The coordinate system  
 (reviews 3.1, 4.1,   b) Graphing lines 2 hours 
 4.2) Finding Equations a) Slope and intercepts  
   b) Finding the equation of a line  
EII.F Absolute Value Solving Equations a) Solving |x| = a  
 (New material)  b) Solving |Ax + B| = a 3 hours 
   c) Solving |Ax + B| = |Cx + D|  
  Solving Inequalities a) Solving absolute value inequalities  

 
Topic 9: Rational Exponents and Radicals 

9.1 Roots and Radicals Square Roots and  a) Definition of square root and cube root  
  Cube Roots b) Radicand, radical  
   c) Principal square root  
   d) Multiplication and division properties  
   e) Simplifying a square root or a cube root of a 

whole number 
 

   f) Simplifying a square root or a cube root of simple 
monomial expression 

 

  Radical Expressions a) Simplifying radical expressions 3 hours 
   b) Like radical terms  
   c) Simplifying a sum or difference of radical 

expressions 
 

   d) Multiplying radical expressions  
   e) Conjugates  
   f) Rationalizing the denominator  
   g) Solving radical equations  
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9.2 Rational Exponents Roots and Exponents a) The nth root of a number  
   b) Definition of a1/n and am/n  
   c) Properties of rational exponents  
  Simplifying Radicals a) Simplifying radicals 4 hours 
  Operations on  a) Multiplying radical expressions  
  Radicals b) Dividing radical expressions  
   c) Adding and subtracting radical expressions  

 
Topic 10: Quadratic Equations 

10.1 Quadratic Equations I Solving by Factoring  a) The standard form of a quadratic equation  
   b) Putting a quadratic equation into standard form 

ax2 + bx + c = 0; a ≠ 0 
 

   c) Solving quadratic equations of the form 
ax2 + bx = 0  by factoring 

 

   d) Solving quadratic equations of the form   
ax2 + bx + c = 0 by factoring 

2 hours 

  Solving by Square  a) Finding square roots  
  Roots b) Solving quadratic equations of the form               

ax2 = b 
 

   c) Solving quadratic equations of the form               
(ax + b)2 = c 

 

10.2 Quadratic Equations II Completing the Square a) Solving quadratic equations of the form  
x2 + bx + c = 0 by completing the square 

 

   b) Solving quadratic equations of the form   
ax2 + bx + c = 0, a ≠ 1, by completing the square 

 

  The Quadratic  a) Introducing the quadratic formula 3 hours 
  Formula b) Using the quadratic formula to solve                     

quadratic equations of the form ax2 + bx + c = 0       
 

   c) Using the discriminant of a quadratic equation to 
determine the nature of the solutions of the 
equation 

 

10.3 Complex Numbers Complex Number  a) Definition of complex numbers  
  System b) Powers of i 2 hours 
   c) Operations on complex numbers  

 
Topic 11: Functions and Graphing 

11.1 Functions Functions and Graphs a) Definition of a function  
   b) Function as an ordered pair of numbers  
   c) Finding function values given a formula  
   d) Function notation: y = f(x)  
   e) Graphing simple functions 4 hours 
   f) Domain and range of a function  
   g) The vertical line test  
  Linear Functions a) Graphs of linear functions  
   b) Graphs of absolute value functions  
  Quadratic Functions a) Graphs of quadratic functions  
   b) Intercepts of quadratic functions  
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11.2 The Algebra of The Algebra of  a) The sum and difference of functions  
 Functions Functions b) The product and quotient of functions  
   c) The composition of functions  
  Inverse Functions a) Finding the inverse and the equation of the 

inverse 
4 hours 

   b) Defining one-to-one and checking whether a 
function has an inverse that is a function 

 

   c) Graphing inverse functions  
 

Topic 12: The Exponential and Logarithmic Functions 
12.1 Exponential Functions The Exponential 

Function 
a) Recognizing and graphing an exponential function  

   b) Applications of the exponential function 2 hours 
   c) The algebra of exponential functions  
12.2 Logs and Their 

Properties 
The Logarithmic 
Function 

a) Converting from exponents to logarithms and 
from logarithms to exponents 

 

   b) Recognizing and graphing a logarithmic function 2 hours 
  Logarithmic Properties a) The algebra of logarithmic functions  
12.3 Applications of Logs Natural and Common a) Base e and natural logarithms  
  Logs b) Finding logs in base 10 and finding powers of 10, 

using a calculator 
 

   c) Finding logs in base e and powers of e, using a 
calculator 

2 hours 

   d) Change of base formula  
  Solving Equations a) Solving exponential equations  
   b) Solving logarithmic equations  

 
Topic 13: More Nonlinear Equations and Inequalities 

13.1 Nonlinear Equations Solving Equations a) Solving polynomial equations by factoring  
   b) Solving quadratic-type equations by factoring or 

by substitution 
 

  Radical Equations a) Solving ax b + = cx + d 3 hours 

   b) Solving ax b cx d + + + = ex + f  

   c) Solving ax b cx d n n + = +   

   d) Solving equations that contain rational exponents  
13.2 Nonlinear Systems Solving Systems a) The solution of a nonlinear system  
   b) Solving nonlinear systems by graphing  
   c) Solving nonlinear systems by the addition method 2 hours 
   d) Solving nonlinear systems by the substitution 

method 
 

13.3 Inequalities Quadratic Inequalities a) Solving quadratic inequalities 4 hours 
  Rational Inequalities a) Solving rational inequalities  
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Topic EIII: Essentials of Algebra 

EIII.A Algebra Building Blocks 
(reviews 1.1, 1.3, 

Real Numbers and 
Notation 

a) Number line and notation: sets, ordering  
symbols, absolute value and distance 

 

 6.1, 8.1, 9.1)  b) Operations on signed numbers  
   c) Properties of real numbers: commutative law, 

associative law, distributive law, additive and 
multiplicative identities, inverses  

3 hours 

  Exponents and  a) Nonnegative integer exponents  
  Radicals b) Negative integer exponents  
   c) Roots and rational exponents  
   d) Properties of exponents  
   e) Operations on radicals  
EIII.B Algebraic Expressions 

(reviews 2.1, 6.2,  
Polynomials a) Algebra building blocks: constants, variables, 

terms and coefficients 
 

 7.1, 7.2, 8.1, plus   b) Adding and subtracting polynomials  
 **new material)  c) Multiplying and dividing polynomials  
   d) Factoring out the greatest common factor  
   e) Factoring by grouping  
   f) Factoring trinomials  
   g) Factoring a difference of 2 squares 3 hours 
   h) Factoring sums and differences of 2 cubes  
   i) Factoring other algebraic expressions **  
  Rational Expressions a) Writing rational expressions in lowest terms  
   b) Multiplying and dividing rational expressions  
   c) Adding and subtracting rational expressions  
EIII.C Equations and  Linear and Absolute  a) Solving linear equations  
 Inequalities Value b) Interval notation**  
 (reviews 2.2, 2.4,  c) Solving linear inequalities  
 3.1, 4.1, 4.2, EII.F,    d) Solving absolute value equations  
 10.1, 10.2, plus   e) Solving absolute value inequalities  
 **new material) Quadratic a) Solving quadratic equations: by factoring, by the 

square root method, by completing the square, by 
the quadratic formula 

 

   b) Complex numbers  
   c) The discriminant 3 hours 
   d) Solving other polynomial equations  
  Linear Equations a) Cartesian coordinate system  
   b) Distance formula  
   c) Midpoint of a line segment**  
   d) Finding the equation of a line: point-slope form, 

standard form, slope-intercept form, horizontal line, 
vertical line, line parallel or perpendicular to a given 
line 
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EIII.D Functions Functions and Graphs a) Function notation  
 (reviews 11.1,   b) Difference quotients**  
 11.2, plus   c) Graphing functions  
 **new material)  d) Domain and range of a function  
   e) Linear functions  
   f) Absolute value functions 3 hours 
   g) Quadratic functions: vertex and intercepts  
  The Algebra of 

Functions 
a) Sum, difference, product, and quotient of two 
functions 

 

   b) Composition of functions  
   c) Inverse functions  
EIII.E Exponents and  Exponential Functions a) Graphing exponential functions  
 Logarithms  b) Applications of exponential functions  
 (reviews 12.1, 12.2,  c) Solving some exponential equations  
 12.3) Logarithmic Functions a) Exponential and logarithmic form  
   b) Graphing logarithmic functions  
   c) Properties of logarithms 3 hours 
  Solving Equations a) Using a calculator to approximate common and 

natural logarithms 
 

   b) Change of base formula  
   c) Solving logarithmic equations  
   d) Solving exponential equations  
EIII.F Finding Solutions Equations and  a) Solving quadratic inequalities  
 (reviews 13.1, 13.3) Inequalities b) Solving rational inequalities 3 hours 
   c) Solving equations which contain radical 

expressions 
 

 
Topic 14: Nonlinear Functions and the Theory of Equations 

14.1 Nonlinear Functions Polynomial Functions a) Recognizing polynomial functions  
   b) Symmetry  
   c) Even and odd functions  
   d) Graphing polynomial functions  
   e) Translations and reflections 6 hours 
  Rational Functions a) Recognizing rational functions  
   b) Determining vertical and horizontal asymptotes  
   c) Graphing rational functions  
14.2 Theory of Equations Polynomial Division a) Dividing a polynomial by a polynomial (polynomial 

long division) 
 

   b) Synthetic division   
   c) The Remainder Theorem  
  The Factor Theorem a) The Factor Theorem  
   b) The Fundamental Theorem of Algebra  
  Zeros of Polynomials a) Rational zeros of a polynomial 8 hours 
   b) Complex zeros of a polynomial  
   c) Descartes’ Rule of Signs  
   d) Bounds on the zeros of a polynomial  
   e) The Intermediate Value Theorem  
   f) Irrational zeros of a polynomial  
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Topic 15: Conic Sections 

15.1 Graphs of Conic  Circles and Parabolas a) The equation of a circle  
 Sections  b) Finding the center and radius of a circle by 

completing the square 
 

   c) Graphing a circle  
   d) The equation of a parabola  
   e) Finding the vertex and orientation of a parabola 

by completing the square 
 

   f) Graphing a parabola  
   g) The focus, directrix, and latus rectum of a 

parabola 
 

  Ellipses a) The equation of an ellipse 6 hours 
   b) Writing the equation of an ellipse in standard 

form by completing the square 
 

   c) Graphing an ellipse  
  Hyperbolas a) The equation of a hyperbola  
   b) Writing the equation of a hyperbola in standard 

form by completing the square 
 

   c) Finding the fundamental rectangle and asymptotes 
of a hyperbola 

 

   d) Graphing a hyperbola  
 

Topic 16: Matrices and Determinants 
16.1 Determinants Determinants a) Definition of matrix  
   b) Definition of a determinant  
   c) Basic properties of determinants 6 hours 
  Cramer’s Rule a) Solution of a linear system by Cramer’s Rule  
  Partial Fractions a) Partial fractions  
16.2 Matrices The Algebra of  a) Basic properties of matrices  
  Matrices b) Equality of matrices and addition, subtraction, and 

scalar multiplication of matrices 
 

   c) Product of matrices 4 hours 
   d) The inverse of a matrix  
  The Gauss-Jordan  a) Linear systems and matrices  
  Method b) The Gauss-Jordan Method  
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Topic 17: Induction, Sequences and Counting 

17.1 Sequences and  Arithmetic a) Definition and notation for a sequence  
 Series  b) Arithmetic sequences and finding the nth term  
   c) Sum of the first n terms of an arithmetic sequence  
  Geometric a) Geometric sequences and finding the nth term 4 hours 
   b) Sum of the first n terms of a geometric sequence  
   c) Sigma notation for a sum  
   d) Finding an “infinite sum” for certain geometric 

sequences 
 

17.2 Induction; Binomial  Mathematical Induction a) Proof by mathematical induction  
 Theorem Binomial Theorem a) Binomial expansions and Pascal’s Triangle  
   b) Definition of n! 4 hours 
   c) Finding binomial coefficients  
   d) The Binomial Theorem  
17.3 Counting and Methods of Counting a) Multiplication principle of counting  
 Probability  b) Permutations  
   c) Combinations  
  Probability a) Basics of probability 4 hours 
   b) How to calculate the probability that one event 

or another event occurs 
 

   c) How to calculate the probability that one event 
and another event occur 
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